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1 SAP Merchandise Planning

1.1 Naming Conventions

Throughout this document the following naming conventions apply.

Definitions

The following terms are used consistently in the processes and procedures described in this guide:

Term Definition

back-end system The SAP NetWeaver-based back-end server on which SAP Customer Activity Repository
and its consuming applications (such as SAP Merchandise Planning, SAP Assortment Plan-
ning, and SAP Promotion Management) are installed.

Common Installation Guide Common Installation Guide for CARAB

You can find this guide at http://help.sap.com/viewer/p/CARAB## <your version>
| Installation and Upgrade # Common Installation Guide CARAB 4.

Common Upgrade Guide Common Upgrade Guide for CARAB

You can find this guide at http://help.sap.com/viewer/p/CARAB#& <your version>
|} Installation and Upgrade > Common Upgrade Guide CARAB }
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Naming Differences

Due to naming differences between the underlying technical objects of the components, the names of the
following business objects are used interchangeably in this document:

SAP Customer Demand Data SAP Promotion SAP Assortment  SAP Merchandise SAP ERP
Activity Reposi- Foundation (DDF) Management Planning Planning
tory with Unified De-

mand Forecast

(UDF)
article product location product product product article

ifi duct
(specific produc material

in a specific loca-
tion)

article variant product variant product variant

product variant

product variant

article variant

store location location

location

location

store

site

1.2 Getting Started

About this Document

This document is a single source of information for the implementation of SAP Merchandise Planning and is

divided into the following main sections:

e [ntroduction with references to related documents and relevant SAP notes

e Security Information

e QOperation Information

® Business Overview

e Configuration Information

i Note

If you are reading from a .pdf file, you can find the most current version of this document at http://

help.sap.com/viewer/p/CARABF| <your release> » Administration » SAP Merchandise Planning

Administration Guide 3.

We strongly recommend that you use the document available there. The guide will be updated according to

updates of the software.
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Installation and Configuration

For information on planning and installation, http://help.sap.com/viewer/p/CARAB#&|¥ <your release>

Installation and Upgrade » Common Installation Guide 3.

For information on upgrades, see the [ Follow-Up Activities » Merchandise Planning for Retail 4 section at

http://help.sap.com/viewer/p/CARAB# |} <your release> ¥ Installation and Upgrade » Common Upgrade

Guide 3.

Related Information

For more information about implementation topics not covered in this guide, see the following:

Content

Location on SAP Help Portal

Sizing, calculation of
hardware requirements -
such as CPU, disk and
memory resource - with
the Quick Sizer tool

https://www.sap.com/about/benchmark/sizing.htm| #

Released platforms and
technology-related topics
such as maintenance
strategies and language
support

https://support.sap.com/en/release-upgrade-maintenance.htm|#

High Availability

http://www.sdn.sap.com/irj/sdn/ha

Performance

https:/www.sap.com/about/benchmark/sizing/performance.htm| ¥

Information about Sup-

port Package Stacks, lat-
est software versions and
patch level requirements

https://support.sap.com/en/my-support/software-downloads/support-package-stacks.html

i

Information about Uni-
code technology

http://www.sdn.sap.com/irj/sdn/i18n "

Further Useful Links

The following table lists further useful links on SAP Help Portal: https:/support.sap.com/en/index.htm|
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Content

Location on SAP Help Portal

Information about incident reporting/error messages

https://help.sap.com/viewer/get-support

SAP Notes search

http://support.sap.com/notes

SAP Software Distribution Center (software download and
ordering of software)

http://support.sap.com/swdc ¥

SAP Online Knowledge Products - role-specific learning
maps

https://support.sap.com/esafe
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2 Security Information

2.1 Why is Security Important?

With the increasing use of distributed systems and the Internet for managing business data, the demands on
security are also on the rise. When using a distributed system, you need to be sure that your data and
processes support your business needs without allowing unauthorized access to critical information. User
errors, negligence, or attempted manipulation of your system should not result in loss of information or
processing time. These demands on security apply likewise to SAP Merchandise Planning. To assist you in
securing SAP Merchandise Planning, we provide this security information.

Fundamental Security Guides

SAP Merchandise Planning is an add-on to SAP Customer Activity Repository. Therefore, the corresponding
security information also applies to SAP Merchandise Planning. The most relevant sections or specific

restrictions are indicated in the table below:

Fundamental Security Guides

Scenario, Application or Component Security Guide

Most Relevant Sections or Specific Restrictions

SAP Customer Activity Repository Security Guide

http://help.sap.coml'h-» Customer Relationship Mgmt >
SAP Customer Activity Repository @ Security Information 4

SAP NetWeaver Application Server ABAP Security Guide

http://help.sap.com/nw75|} Security Information >
Security Guide ¥ Security Guides for SAP NetWeaver
Functional Units > Security Guides for the Application Server
» Security Guides for AS ABAP » SAP NetWeaver
Application Server ABAP Security Guide 4

SAP HANA Security Guide

http://help.sap.com/hana/ | SAP HANA Platform Core
> Security > SAP HANA Security Guide ]

SAP NetWeaver 7.4 Security Guide

http://help.sap.com/nw75|} Security Information >
Security Guide }

SAP ERP 6.0 EHP 5 Security Guide

http://help.sap.com/erp/"h-l} Security Information >
Security Guide » SAP ERP Central Component Security
Guide 3
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Scenario, Application or Component Security Guide

Most Relevant Sections or Specific Restrictions

Portal Security Guide

http:/help.sap.com/nw75|F Security Information ¥
Security Guide > Security Guides for SAP NetWeaver
Functional Units ¥ Security Guides for Enterprise Portal (EP)
and EP Core - Application Portal (EPC) > Portal Security
Guide J

SAP Gateway Security Guide

http://help.sap.com/nwgateway #r

SAP BusinessObjects Analysis, edition for Microsoft Office
2.3SP3

http://help.sap.com/viewer/p/SAP_BUSINESSOB-
JECTS_ANALYSIS_OFFICE# |+ SAP BusinessObjects
Analysis, edition for Microsoft Office > Installation,
Configuration, Security and Administration > Administrator's

Guide 3

Important SAP Notes

The most important SAP Notes that apply to the security of SAP Merchandise Planning are shown in the

following table:

Title SAP Note Number

Comment

SAP HANA 1.0: Security
notes/159623 #

https://launchpad.support.sap.com/#/

Contains information and links to other
notes related to the secure operation of
SAP HANA

Authorization Check for Function Mod-
ules in SAP Customer Activity Reposi-  notes/1940161 %%

tory and SAP POS DM

https://launchpad.support.sap.com/#/

Contains information about authoriza-
tion objects required to support inte-
gration scenarios involving systems
connected to SAP Customer Activity
Repository using RFC connections.

2.2 Security Aspects of Data, Data Flow and Processes

The figure below describes an overview of the data flow for SAP Merchandise Planning for Retail.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
Security Information

PUBLIC


http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnwgateway
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fp%2FSAP_BUSINESSOBJECTS_ANALYSIS_OFFICE
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fp%2FSAP_BUSINESSOBJECTS_ANALYSIS_OFFICE
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fnotes%2F159623
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fnotes%2F159623
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fnotes%2F1940161
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fnotes%2F1940161

SBOA
Analysis Office

SAP NetiWeaver

0
( SAPHANA )

For more information about the technical system landscape, see the Common Installation Guide.

The table below shows the security aspect to be considered for the process step and what mechanism applies.

Step Description Security Measure

Connect the Application servertothe ~ The application server connects tothe ~ ®  Definition and implementation
SAP HANA database. SAP HANA database via a trusted RFC Application customizing

and gets the required information. This e  RFC setup for trusted GW SSO

is created as part of the installationand o  gap xxX (SAP server) user default
system setup.

2.3 User Administration and Authentication

User Management

User management for SAP Merchandise Planning uses the mechanisms provided with the SAP NetWeaver
Application Server ABAP, for examples, user types, and password policies. For an overview of how these
mechanisms apply for SAP Merchandise Planning for Retail, see the sections below.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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The SAP HANA Content for SAP Merchandise Planning uses the user management and authentication
mechanisms provided with the SAP HANA Platform. Therefore, the security recommendations and guidelines
for user administration and authentication as described in the Security section of the SAP HANA
Administration Guide also apply.

Similarly, other components of the technical system landscape for SAP Merchandise Planning for Retail, such
as SAP ERP Central Component (ECC) and/or SAP NetWeaver Process Integration (Pl), also use the
mechanisms provided with the SAP NetWeaver AS ABAP. For an overview of how these mechanisms apply for
SAP Merchandise Planning, see the sections below.

User Administration Tools

The table below shows the tools to use for user management and user administration with SAP Merchandise
Planning.

Tool Detailed Description Prerequisites

User and role maintenance with SAP For more information see: The SAP NetWeaver Application Server
NetWeaver AS ABAP (Transactions
SUQ1, PFCG)

e AS ABAP Authorization Conceptin 'S NMNE:

the SAP NetWeaver Application
Server ABAP Security Guide

e SAP Library for SAP NetWeaver on
SAP Help Portal at http://
help.sap.com/nw75Under Applica-

tion Help, choose |} Function-
Oriented View # Solution Life Cycle
Management > Security and User

Administration 1

User Types

It is often necessary to specify different security policies for different types of users. For example, your policy
may specify that individual users who perform tasks interactively have to change their passwords on a regular
basis, but not those users under which background processing jobs run. The user types that are required for
SAP Merchandise Planning:

e |ndividual Users:
o Dialog users are used for interactive system access, such as SAP GUI for Windows or RFC connections.
o Internet users are used for internet connections.
o Named users are required for all Business Intelligence clients like SAP BusinessObjects Bl Suite Uls.
e Technical users:
o Communication users are used for dialog-free communication through RFC calls.

o Background users are used for background processing and communication within the system, such
as, running scheduled inbound or outbound dispatcher jobs.

For more information about these user types, see User Types in the SAP NetWeaver AS ABAP Security Guide.
Standard Users

SAP Merchandise Planning does not require specialized standard users. The POS Data Management
component of SAP Merchandise Planning indirectly uses SAP NetWeaver standard users.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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For information about SAP NetWeaver standard users, see Protecting Standard Users in the SAP NetWeaver
Application Server ABAP Security Guide.

- Recommendation

We recommend changing the user IDs and passwords for users that are automatically created during
installation.

User Data Synchronization

The application does not deliver additional user data synchronization related features in addition to those
available in the SAP NetWeaver platform. It also does not impose any special needs or restrictions, which would
limit the usage of related NetWeaver tools.

i Note

For any scenarios where system inter-connectedness at the user level is a requirement, it is mandatory that
the same users exist throughout all the pertinent connected systems in the landscape.

Integration into Single Sign-On Environments

SAP Merchandise Planning supports the Single Sign-On (SSO) mechanisms provided by SAP NetWeaver AS
ABAP. Therefore the security recommendations and guidelines for user administration and authentication as
described in the SAP NetWeaver Security Guide also apply to SAP Merchandise Planning.

For more information about the available authentication mechanisms, see User Authentication and Single Sign-
Oninthe SAP NetWeaver Library.

2.4 Authorizations

SAP Merchandise Planning uses the authorization concept provided by SAP NetWeaver AS ABAP. Therefore,
the recommendations and guidelines for authorization as described in the SAP NetWeaver AS Security Guide
ABAP also apply to SAP Merchandise Planning.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For
role maintenance, use the profile generator (transaction PFcG) on the AS ABAP.

i Note

For more information about how to create roles, see Role Administration in the SAP Netweaver Library

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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Role and Authorization Concept for SAP Merchandise Planning

Standard Roles

The SAP Merchandise Planning application requires a layered system landscape. As an assortment planner or
planning administrator, you must have the necessary users, roles and authorizations in all of the layers of the

SAP Merchandise Planning application.

e Back-end server

To access the relevant Customizing activities and use core SAP Merchandise Planning application
functionality, you must have a user on the ABAP back-end server.

e SAP HANA Database

To allow the SAP Merchandise Planning application to access SAP HANA views and procedures, which
provide access to data and functionality directly on the database level, you must have a user on the

database level.

SAP HANA has implemented the regular SQL authorization concept based on privileges. For information,
see http:/help.sap.com/hanat | SAP HANA Platform Core » Security » SAP HANA Security Guide 3

Standard Roles

Role

Description

/RAP/BW_MPR WORKBOOKS

Grants access to the following SAP Merchandise Planning
workbooks that are based on SAP BusinessObjects Analysis,
edition for Microsoft Office.

e 1.1 Regional Monthly Plan

e 1.2 Regional Seasonal Plan

e 13 Regional Seasonal Plan

e 2.1 Retail Monthly Plan

e 3.1 Wholesale Monthly Plan

e 41Ecommerce Monthly Plan
e 510TB & OTS Reconciliation

Role

Description

SAP Customer Activity Repository co-deployed with SAP
ERP

Directly from the SAP ERP database schema (SAP_ECC) on
the SAP HANA database

SAP Customer Activity Repository standalone

From tables replicated to a dedicated SAP Customer Activity
Repository schema from the source SAP ERP system

Verify Users and Roles

Procedure

1. Ensure that the user name of each individual assortment planner or planning administrator on the SAP
HANA database level and back-end system is identical.

2. Ensure the required user settings on the SAP HANA database level:

o Each SAP BW/HANA user at least needs following set of privileges:

© Privilege SELECT onschema sSyS BI

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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o

o Privilege SELECT on schema SAP<SID>

o Privilege EXECUTE on procedure REPOSITORY REST

o Privilege REPO.READ on package bw2hana/SAP<SID> /RAP/<Infocube> REPORTING
The corresponding privileges will be created automatically when activating Bl Content.

Each SAP user should also have the following set of privileges

o System privilege ROLE ADMIN

o System privilege

O STRUCTUREDPRIVILEGE ADMIN

© Role CONTENT ADMIN

© Role USER

o Privilege EXECUTE on procedure TRUNCATE PROCEDURE_OBJECTS

© Privilege EXECUTE on procedure GET PROCEDURE OBJECTS

o Session Client of each user has to be set to the correct back-end system client.
1. Logonto SAP HANA studio

2. Open the Modeler perspective and use the Navigator to access your retail application bundle
system.

3. Under Security, select a user.

4. Set the Session Client to the client number.

This step is necessary for the SAP Merchandise Planning framework as the SAP Analysis for
Microsoft Office workbooks obtain data from SAP HANA views.

o Repeat these steps for all users of the back-end system.

3. Ensure that the planner has all necessary roles and authorization objects assigned to their user on the
back-end server:

i

2.5

Log on to the back-end server.

2. Open User Management (transaction su01)
3.
4. Onthe Roles tab, verify that the following roles are assigned to the user:

Enter the name of the user and select Change.

© SAP ISR DDF MASTER
© /RAP/BW_MPR_WORKBOOKS
Set the SAP HANA User Mapping to C in transaction RS2HANA VIEW.

If required, enable tracing for the user with transaction su3. On the Parameters tab, set the
RSPLS HDB_ PE TRACE parameter to value Y

Session Security Protections

To increase security and prevent access to the SAP logon ticket and security session cookie(s), we recommend
activating secure session management. We also highly recommend using SSL to protect the network
communications where these security-relevant cookies are transferred.

14
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2.6 ABAP Server Session Security

For the ABAP front-end server, you must activate HTTP security session management by using the transaction
SICF SESSIONS. When you activate HTTP security session management, we recommend you activate the
following extra protection for security-related cookies:

® HttpOnly
This attribute instructs the browser to deny access to the cookie through client side script. As a result,
even if a cross-site scripting (XSS) flaw exists and a user accidentally accesses a link that exploits this flaw,
the browser will not reveal the cookie to a third party.

® Secure
This attribute instructs the browser to send the cookie only if the request is being sent over a secure
channel such as HTTPS. This helps protect the cookie from being passed over unencrypted requests.

- Recommendation

It is recommended that you configure the HTTP session expiration with a reasonable timeout of between 10
minutes to 1 hour. To configure this, you use the profile parameter http/security session timeout.

2.7 Network and Communication Security

Your network infrastructure is extremely important in protecting your system. Your network needs to support
the communication necessary for your business needs without allowing unauthorized access. A well-defined
network topology can eliminate many security threats based on software flaws (at both the operating system
level and application level) or network attacks such as eavesdropping. If users cannot log on to your application
or database servers at the operating system or database layer, then there is no way for intruders to
compromise the machines and gain access to the backend system's database or files. Additionally, if users are
not able to connect to the server LAN (local area network), they cannot exploit well-known bugs and security
holes in network services on the server machines.

The network topology for SAP Merchandise Planning for Retail is based on the topology used by the SAP
NetWeaver platform. Therefore, the security guidelines and recommendations described in the SAP NetWeaver
Security Guide also apply to SAP Merchandise Planning for Retail. Details that specifically apply to SAP
Merchandise Planning for Retail are described in the following topics:

e Communication Channel Security
This topic describes the communication paths and protocols used by the application.

e Network Security
This topic describes the recommended network topology for the application. It shows the appropriate
network segments for the various client and server components and where to use firewalls for access
protection. It also includes a list of the ports needed to operate the application.

e Communication Destinations
This topic describes the information needed for the various communication paths, for example, which
users are used for which communications.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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Communication Channel Security

The table below shows the communication paths used by SAP Merchandise Planning fro Retail, the protocol
used for the connection, and the type of data transferred.

Communication Path Protocol Used Type of Data Transferred Data Requiring Special Pro-
tection

Application Server to appli- RFC Application data System information, per-

cation server sonal data and transactional
data

DIAG and RFC connections can be protected using Secure Network Communications (SNC). HTTP
connections are protected using the Secure Sockets Layer (SSL) protocol. SOAP connections are protected
with Web services security.

-> Recommendation
We strongly recommend using secure protocols (SSL, SNC) whenever possible.

For more information, see Transport Layer Security and Web Services Security in the SAP NetWeaver Security
Guide.

Network Security

The network topology for SAP Merchandise Planning for Retail is based on the topology used by the SAP
NetWeaver platform. Therefore, refer to the following documentation for information on network security:

SAP NetWeaver 7.50
SAP Supply Chain Management Security Guide

SAP Supplier Relationship Management Security Guide

SAP Customer Activity Repository Security Guide
Ports

SAP Merchandise Planning for Retail runs on SAP NetWeaver and uses the ports from the AS ABAP. For more
information, see the topics for AS ABAP Ports in the corresponding SAP NetWeaver Application Server ABAP

Security Guide . For other components, for example, SAPinst, SAProuter, or the SAP Web Dispatcher, see also
the document TCP/IP Ports Used by SAP Applications, which is located on SAP Community Network (SCN) at

http://scn.sap.com/community/security® |l Infrastructure Security ¥ Network and Communication Security 3

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
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Communication Destinations

The table below shows an overview of the communication destinations used by SAP Merchandise Planning for
Retail:

Destination Type User, Authorizations Description
SAP ERP Retail Trusted RFC Connection Standard RFC user configu-  Connecting SAP ERP System
ration for DRFOUT, SLT and creat-

ing Assortments

2.8 Data Storage Security

SAP Merchandise Planning for Retail saves data in the SAP HANA database of the SAP system. It relies on the
underlying security features available in HANA for data protection.

2.9 Data Protection and Privacy

Introduction [page 17]
Glossary [page 19]

2.9.1 Introduction

Data protection is associated with numerous legal requirements and privacy concerns. In addition to
compliance with general data protection and privacy acts, it is necessary to consider compliance with industry-
specific legislation in different countries. SAP provides specific features and functions to support compliance
with regard to relevant legal requirements, including data protection. SAP does not give any advice on whether
these features and functions are the best method to support company, industry, regional, or country-specific
requirements. Furthermore, this information should not be taken as advice or a recommendation regarding
additional features that would be required in specific IT environments. Decisions related to data protection
must be made on a case-by-case basis, taking into consideration the given system landscape and the
applicable legal requirements.

i Note

SAP does not provide legal advice in any form. SAP software supports data protection compliance by
providing security features and specific data protection-relevant functions, such as simplified blocking and
deletion of personal data. In many cases, compliance with applicable data protection and privacy laws will
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not be covered by a product feature. Definitions and other terms used in this document are not taken from
a particular legal source.

A Caution

The extent to which data protection is supported by technical means depends on secure system operation.
Network security, security note implementation, adequate logging of system changes, and appropriate
usage of the system are the basic technical requirements for compliance with data privacy legislation and
other legislation.

Generic Fields

You need to make sure that no personal data enters the system in an uncontrolled or non-purpose related way,
for example, in free-text fields, through APIs, or customer extensions. Note that these are not subject to the
read access logging (RAL) example configuration.

SAP Merchandise Planning

Data protection and privacy (DPP) related functionality has been implemented in the Demand Data Foundation
(DDF) module in SAP Customer Activity Repository. DDF includes a reusable data layer that supports the
planning, analysis, and forecasting required by different business processes. DDF acts as a liaison between the
consuming application installed on top of SAP Customer Activity Repository and the modules within the
repository that provide these business processes.

Details about DPP implementation in DDF are available in the Customer Activity Repository Administration
Guide. See https:/help.sap.com/viewer/p/CARAB | <Version> » SAP Customer Activity Repository »

Administration Guide  Security Information j» Data Protection and Privacy 3. Topics specific to DDF:

e Reporting or displaying personal data stored: Information Report.

e Simplified blocking of personal data: Deletion of Personal Data section Expected Behavior Within Demand
Data Foundation (DDF).

Parent topic: Data Protection and Privacy [page 17]

Related Information

Glossary [page 19]

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
18 PUBLIC Security Information


https://help.sap.com/viewer/p/CARAB

2.9.2 Glossary

The following terms are general to SAP products. Not all terms may be relevant for this SAP product.

Term

Definition

Blocking

A method of restricting access to data for which the primary
business purpose has ended.

Business Purpose

The legal, contractual, or in other form justified reason for
the processing of personal data to complete an end-to-end
business process. The personal data used to complete the
process is predefined in a purpose, which is defined by the
data controller. The process must be defined before the per-
sonal data required to fulfill the purpose can be determined.

Consent

The action of the data subject confirming that the usage of
his or her personal data shall be allowed for a given purpose.
A consent functionality allows the storage of a consent re-
cord in relation to a specific purpose and shows if a data
subject has granted, withdrawn, or denied consent.

Data Subject

Any information relating to an identified or identifiable natu-
ral person ("data subject"). An identifiable natural person is
one who can be identified, directly or indirectly, in particular
by reference to an identifier such as a name, an identification
number, location data, an online identifier, or to one or more
factors specific to the physical, physiological, genetic, men-
tal, economic, cultural, or social identity of that natural per-
son.

Deletion

Deletion of personal data so that the data is no longer avail-
able.

End of business

Defines the end of active business and the start of residence
time and retention period.

End of Purpose (EoP)

The point in time when the processing of a set of personal
data is no longer required for the primary business purpose,
for example, when a contract is fulfilled. After the EoP has
been reached, the data is blocked and can only be accessed
by users with special authorizations (for example, tax audi-
tors).

End of Purpose (EoP) check

A method of identifying the point in time for a data set when
the processing of personal data is no longer required for the
primary business purpose. After the EoP has been reached,
the data is blocked and can only be accessed by users with
special authorization, for example, tax auditors.
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Term

Definition

Personal Data

Any information relating to an identified or identifiable natu-
ral person ("data subject"). An identifiable natural person is
one who can be identified, directly or indirectly, in particular
by reference to an identifier such as a name, an identification
number, location data, an online identifier, or to one or more
factors specific to the physical, physiological, genetic, men-
tal, economic, cultural, or social identity of that natural per-
son.

Purpose

The information that specifies the reason and the goal for
the processing of a specific set of personal data. As a rule,
the purpose references the relevant legal basis for the proc-
essing of personal data.

Residence Period

The period of time between the end of business and the end
of purpose (EoP) for a data set during which the data re-
mains in the database and can be used in case of subse-
quent processes related to the original purpose. At the end
of the longest configured residence period, the data is
blocked or deleted. The residence period is part of the over-
all retention period.

Retention Period

The period of time between the end of the last business ac-
tivity involving a specific object (for example, a business
partner) and the deletion of the corresponding data, subject
to applicable laws. The retention period is a combination of
the residence period and the blocking period.

Sensitive Personal Data

A category of personal data that usually includes the follow-
ing type of information:

® Special categories of personal data, such as data reveal-
ing racial or ethnic origin, political opinions, religious or
philosophical beliefs, trade union membership, genetic
data, biometric data, data concerning health or sex life
or sexual orientation.

® Personal data subject to professional secrecy

® Personal data relating to criminal or administrative of-
fenses

® Personal data concerning insurances and bank or credit
card accounts
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Term Definition

Technical and Organizational Measures (TOM) Some basic requirements that support data protection and
privacy are often referred to as technical and organizational
measures (TOM). The following topics are related to data
protection and privacy and require appropriate TOMs, for ex-
ample:

® Access control Authentication features

e Authorizations Authorization concept

® Read access logging

® Transmission control/communication security
® |nput control/change logging

e Availability control

e Separation by purpose Subject to the organizational
model implemented and must be applied as part of the
authorization concept.

Parent topic: Data Protection and Privacy [page 17]

Related Information

Introduction [page 17]

2.10 Security-Relevant Logging and Tracing

SAP Merchandise Planning for Retail does not provide additional security logging and tracing above those
available within SAP NetWeaver. For more information on:

e Logging and Tracing for ABAP, see http:/help.sap.com#|» SAP NetWeaver Library 3 Administrator's
Guide » SAP NetWeaver Security Guide ¥ Security Aspects for System Management ¥ Auditing and
Logging 2.

e |ogging and Tracing for NetWeaver Business Client, see http://help.sap.com®|lp SAP NetWeaver Library -
> Administrator's Guide ¥ SAP NetWeaver Security Guide ¥ Security Guides for SAP NetWeaver According
to Usage Types » Security Guides for Usage Types EPC and EP -> Portal Security Guide » Logging and
Tracing ¥ Identity Mangement » User Management of the Application Server Java » Troubleshooting ¥
Logging and Tracing. 3

e |ogging and Tracing for customizing changes, use the scuU3 transaction to activate the logging of changes
to the table data.
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2.11 Services for Security Lifecycle Management

The following services are available from Active Global Support to assist you in maintaining security in your
SAP systems on an ongoing basis.

Security Chapter in the EarlyWatch Alert (EWA) Report

This service regularly monitors the Security chapter in the EarlyWatch Alert report of your system. It tells you:

e \Whether SAP Security Notes have been identified as missing on your system.
In this case, analyze and implement the identified SAP Notes if possible. If you cannot implement the SAP
Notes, the report should be able to help you decide on how to handle the individual cases.

e \Whether an accumulation of critical basis authorizations has been identified.
In this case, verify whether the accumulation of critical basis authorizations is okay for your system. If not,
correct the situation. If you consider the situation okay, you should still check for any significant changes
compared to former EWA reports.

e \Whether standard users with default passwords have been identified on your system.
In this case, change the corresponding passwords to non-default values.

Security Optimization Service (SOS)

The Security Optimization Service can be used for a more thorough security analysis of your system, including:

e C(Critical authorizations in detail

® Security-relevant configuration parameters
e (Critical users

e Missing security patches

This service is available as a self-service within SAP Solution Manager, as a remote service, or as an on-site
service. We recommend you use it regularly (for example, once a year) and in particular after significant system
changes or in preparation for a system audit.

Security Configuration Validation

The Security Configuration Validation can be used to continuously monitor a system landscape for compliance
with predefined settings, for example, from your company-specific SAP Security Policy. This primarily covers
configuration parameters, but it also covers critical security properties like the existence of a non-trivial
Gateway configuration or making sure standard users do not have default passwords.
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Security in the RunSAP Methodology / Secure Operations Standard

With the E2E Solution Operations Standard Security service, a best practice recommendation is available on
how to operate SAP systems and landscapes in a secure manner. It guides you through the most important
security operation areas and links to detailed security information from SAP's knowledge base wherever
appropriate.
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3 Operation Information

3.1 Monitoring

Monitoring is an essential task in managing SAP Technology. Monitoring allows you to detect any irregularities
or deviations from the ideal business process flow. It also allows you to detect error situations concerning core
business processes at an early stage. SAP Merchandise Planning uses frameworks developed in Demand Data
Foundation (DDF) for its monitoring purposes as most of the master data and transaction data comes from
DDF.

SAP Merchandise Planning does not have any specific monitoring implemented unless specified in this guide.
Demand Data Foundation (DDF) internally uses the SAP NetWeaver standard functionality for monitoring. For
more information about this functionality, see the Operation Guides for SAP NetWeaver athttp://help.sap.com/

nw75)» Operations

Alert Monitoring

SAP provides you with the infrastructure and recommendations to set up your alert monitor in such a way that
critical situations are identified as quickly as possible.

Component-Specific Monitoring

Specific CCMS monitoring for SAP Merchandise Planning is not available.

Detailed Monitoring

SAP Merchandise Planning uses standard SAP BW logging and tracing utilities such as transaction code RSRT.

SAP HANA Monitoring

SAP Merchandise Planning uses standard SAP HANA Monitoring tools for monitoring SAP HANA. For more
information, see the SAP HANA Administration Guide at http://help.sap.com/hana_platform#|p System

Administration
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SAP Business Warehouse Monitoring

SAP Merchandise Planning has its own, local Bl Content. SAP Assortment Planning Bl Content uses standard
SAP Business Warehouse (SAP BW) Monitoring tools. You can execute the following tasks to monitor SAP BW
processes and the status of local Bl Content objects for SAP Merchandise Planning:

e Monitoring in the SAP BW Administration Cockpit
o Monitor the performance of SAP BW processes
o Monitor the status of SAP BW processes and requests
o Display the SAP BW usage statistics
© Monitor the database load
e Monitor SAP BW log files
e Display and evaluate SAP BW logs in the application log
e Manage InfoProviders
e Analyze statistical data for SAP BW

For more information about monitoring SAP BW for SAP NetWeaver 7.50, see SAP Library for SAP Gateway on
SAP Help Portal at http://help.sap.com/nw75|» Application Help ¥ Function-Oriented View » SAP Business
Warehouse » Administration of SAP Business Warehouse » Administrative Tasks for Enterprise Data Warehouse

» Tasks performed regularly 3.

SAP BusinessObjects Analysis, edition for Microsoft Office Monitoring

SAP Merchandise Planning uses the standard monitoring functionality of SAP BusinessObjects Analysis,
edition for Microsoft Office Monitoring. SAP BusinessObjects Analysis provides log files and traces. For more
information, see the Administrator Guide: SAP BusinessObjects Analysis, edition for Microsoft Office at http://
help.sap.com/boaaf .

Data Consistency

SAP Merchandise Planning provides no specific functionality to ensure data consistency but uses the
infrastructure of SAP Customer Activity Repository.

3.2 Management

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and
operation.
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Starting and Stopping

Start and Stop Sequences and Tools

Action and Component Sequence

Tool

Detailed Description

Start SAP HANA database 1

sapstartsrv

See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.

Start SAP Systems and In- 2
stances

STARTSAP(for UNIX)

See the information about
starting and stopping SAP
Systems based on SAP Net-
Weaver at http:/
help.sap.com/nw75

|} Application Help >

Function-oriented View >
Solution Lifecycle

Management > Starting and
Stopping SAP Systems Based

on SAP NetWeaver 3.

Start SAP LT Replication 3
Server (Optional)

SAP HANA studio

Use SAP HANA studio to
start replication of tables re-
quired by SAP Merchandise
Planning. For more informa-
tion, see the SAP LT Replica-
tion Server Operations
Guide.

Stop SAP LT Replication 4
Server (Optional)

SAP HANA studio

Use SAP HANA studio to
stop replication of tables re-
quired by SAP Merchandise
Planning. For more informa-
tion, see the SAP LT Replica-
tion Server Operations
Guide.
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Action and Component Sequence Tool Detailed Description

Stop SAP Systems and In- 5 sTopsAP(for UNIX) See the information about

stances starting and stopping SAP
Systems based on SAP Net-
Weaver at http://
help.sap.com/nw75

|} Application Help >

Function-oriented View >
Solution Lifecycle

Management > Starting and
Stopping SAP Systems Based

on SAP NetWeaver ]

Stop SAP HANA database 6 sapstartsrv See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.

Administration Tools

There is no specific administration tool for SAP Merchandise Planning.

SAP Merchandise Planning uses the standard SAP NetWeaver administration tools. For more information, see
SAP Help Portal for SAP NetWeaver at http://help.sap.com/nw# . Choose a release. Choose |+ System
Administration and Maintenance Information » Technical Operations for SAP NetWeaver » Administration of
SAP NetWeaver Systems. 3.

SAP Merchandise Planning for Retail also uses the administration tools available with SAP HANA. For more
information, see SAP Help Portal for SAP HANA platform at http://help.sap.com/hana_appliance# . Choose

|+ System Administration » SAP HANA Technical Operations Manual 3.

SAP Merchandise Planning for Retail also uses the administration tools available with SAP Business
Warehouse. For more information about administration tools for SAP NetWeaver 7.50, see SAP Help Portal at
http://help.sap.com/nw75.

Backup and Restore

You must back up your system landscape regularly to ensure that you can restore and recover it in case of
failure. The backup and restore strategy of your system landscape must not only include your strategy for your
SAP system, but it must also be included in your company's overall business requirements and incorporated
into your entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as how to recover
from the loss of a data center due to a fire. It is important that your strategy specifies that normal data and
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backup data are stored in separate physical locations, so that both types of data are not lost in case of a
disaster. SAP Merchandise Planning is based on SAP NetWeaver technology; therefore, the SAP NetWeaver
backup procedures can also be used for SAP Merchandise Planning.

Subject

Path

Backup and recovery processes for ABAP, JAVA, Business
Intelligence, or Process Integration

See the Technical Operations Manual for SAP NetWeaver at

http://help.sap.com/nw# . Choose a release. Choose
|} System Administration and Maintenance Information >

Technical Operations for SAP NetWeaver ]

Best Practice - Backup and Restore for SAP System Land-
scapes

See SAP Enterprise Support Academy at https://
support.sap.com/en/offerings-programs/enterprise-sup-

port/enterprise-support-academy.htm| .
R

Backing up and recovering the SAP HANA database

See SAP Help Portal for SAP HANA platform at http:/
help.sap.com/hana_appliance®r . Choose |} System
Administration > SAP HANA Administration Guide 1

Periodic Tasks

This section describes the tasks required to run to keep the application running smoothly over time. It is
important that you monitor the successful execution of these tasks on a regular basis.
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Periodic Tasks

Program Name/Task

Task scheduling tool

Recommended Frequency
and method

Detailed Description

DRFOUT (for master data rep- -

lication)

Frequency:

e |nitial setup of the sys-
tem

e \Whenever master data
changes

Method: Manual task

Perform this task in the SAP
ERP system to replicate the
needed master data from
SAP ERP system to the sys-
tem for SAP Merchandise
Planning. Out of possible 15
outbound implementations,
SAP Merchandise Planning
for Retail needs at least the
following outbound imple-
mentations:

e PPHY (Plant Hierarchy)

o PAHY (Article Hierarchy)

e PINV (Inventory)

e  PMAP (Moving Average
Price)

e PMAT (Material)

e PMCH (Material Group
Hierarchy)

e PMPL (Material/Plant)

e PPLT (Plant)

e PSOS (Source of Sup-
ply)

e PSPR (Sales Price)

e PVEN (Vendor)

For more information, see
the Configuring Data Replica-
tion from SAP ERP DDF sec-
tion in the SAP Merchandise
Planning in the Common
Installation Guide.

DRFOUT (for building up In-
ventory History)

Transaction sM36 for sched-
uling a background job

Frequency: Weekly

Method: Scheduled periodic
task

We recommend that you
schedule a weekly periodic
task to replicate inventory
data (outbound implementa-
tion p1NV) from the SAP ERP
system to the system for SAP
Merchandise Planning. This
replication builds up the in-
ventory history data that is
needed by SAP Merchandise
Planning.
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For information about scheduled periodic tasks for SAP NetWeaver 7.5, see http://help.sap.com/nw75

|+ Application Help » Function-oriented View  Search and Operational Analytics » Managing Search and
Operational Analytics  Technical Operations Manual ¥ Administration ¥ Periodic Tasks # Scheduled Periodic
Tasks 4.

3.3 High Availability

SAP Merchandise Planning is based on SAP HANA and SAP NetWeaver technology; all high availability
considerations that apply to SAP HANA and SAP NetWeaver, such as increasing system availability, improving
performance, and eliminating unplanned downtime, also apply to SAP Merchandise Planning.

Additional Information on high availability

Topic Path

General information on high availability strategies for SAP See SAP Help Portal for SAP NetWeaver at http://

NetWeaver-based systems help.sap.com/nw# . Choose a release. Under Application
Help, choose |} Function-Oriented View > Solution Life Cycle
Management > SAP Business Continuity }

General information on high availability strategies for SAP See SAP Help Portal for SAP HANA Platform at http:/
HANA based systems help.sap.com/hana_appliancefr . Under System

Administration , choose | SAP HANA Technical Operations
Manual ]

3.4 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams. The goal of Software Change
Management is to establish consistent, solution-wide change management that allows for specific
maintenance procedures, global rollouts (including localizations), and open integration with third-party
products.

Transport and Change Management

SAP Merchandise Planning uses the infrastructure of SAP NetWeaver.

For transport and change management issues, the procedures of SAP NetWeaver apply. For more information,
see the Transport and Change Management section in the Technical Operations Manual for your SAP NetWeaver
release on SAP Help Portal at http://help.sap.com/netweaver .
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Development Requests and Development Release Management

You use the standard tools and procedures of SAP NetWeaver to transport SAP Merchandise Planning code
extensions or customizing changes. All such changes are captured by the transport system and are
transportable.

For information about procedures for SAP BusinessObjects Analysis, see the section about life-cycle
management with SAP NetWeaver in the Administrator Guide: SAP BusinessObjects Analysis, edition for
Microsoft Office at http://help.sap.com/boaaf.

Additional Information on development requests and development release management

Topic Path

Change and Transport System See SAP Help Portal for SAP NetWeaver at http://
help.sap.com/nw# . Choose a release. Under System
Administration and Maintenance Information, choose

|} Technical Operations for SAP NetWeaver > Administration
of Application Server ABAP }

Change Management for SAP HANA-based systems See SAP Help Portal for SAP HANA platform at http:/
help.sap.com/hana_appliancefr . Under System

Administration, choose | SAP HANA Technical Operations
Manual 3.

Manual correction process for ABAP on SAP HANA See SAP Note 1798895 i .

Support Packages and Patch Implementation

We recommend that you implement SAP NetWeaver (including SAP BW), SAP HANA, SAP Analysis for
Microsoft Office, and SAP Merchandise Planning support package stacks. These support package stacks are
sets of support packages and patches for the respective product version that must be used in the given
combination. The technology for applying support packages and patches will not change.

You can find detailed information about the availability of SP stacks for SAP Customer Activity Repository on
the SAP Support Portal at http://support.sap.com/sp-stacks#. See the corresponding Release Information
Notes (RINs) before you apply any support packages or patches of the selected SP stack.

3.5 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support
organization that seamlessly integrates your end users, internal support employees, partners, and SAP Active
Global Support specialists with an efficient problem resolution procedure. For support desk management, you
need the methodology, management procedures, and tools infrastructure to run your internal support
organization efficiently.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
Operation Information PUBLIC 31


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fboaa
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fhana_appliance
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fhana_appliance
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1798895
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fsp-stacks

Remote Support Setup

If you want to use SAP remote services (for example, SAP EarlyWatch or Remote Consulting), or if you would
like to permit an SAP support consultant to work directly in your system to make a more precise problem
diagnosis, set up a remote service connection. Additionally, there exists an ABAP role for read-only access for
remote support that is also relevant. This role (sap_RCA SAT DISP for ABAP) is available in the STPI plug-in
and is generated when a managed system is connected to SAP Solution Manager. Should any additional
application-specific functionality be necessary for use by an SAP support consultant, then an applicable role
should be defined providing the appropriate authorization(s) and assigned to the SAP support consultant's
user logon.

Problem Message Handover

To create SAP support messages for your installation, you must specify an application component. For SAP
Merchandise Planning, you can specify one of the following application components:

e CA_RT_MPR - to report support messages for general issues.
e CA_RT_MPR_PLN - to report support messages related to the workbook functions.

For more information about reporting incidents, see the SAP Support Portal at https://help.sap.com/viewer/
get-support.

3.6 Troubleshooting

Authorization Issues with External SAP HANA Views for SAP BW InfoCubes

If there are issues with authorization for the external SAP HANA views that retrieve data of SAP BW InfoCubes
that are contained in the package system-local .bw.bw2hana. rap, perform the following steps to solve the
issue:

e FEnsure that users have identical user names in SAP BW and in the SAP HANA database.

e Ensure that the Session Client in the SAP HANA database is set to SAP BW client.

e FEnsure that the SAP HANA User Mapping is set to C (DBMS user or SAP HANA user with the same name as
SAP BW user) using transaction RS2HANA VIEW.

e Check if all necessary authorizations are available for the SAP<SID> user and for any other user. Do this
check by executing the transaction Rs2HANA CHECK. The report states the missing authorizations. Grant
the missing authorizations to the SAP<SID> user.

® You can regenerate BW2HANA authorizations with report RS2HANA AUTH RUN (executed in transaction
SE38). This measure helps especially if RS2ZHANA CHECK reports missing filter values.
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SAP Analysis for Microsoft Office Troubleshooting

General

SAP Merchandise Planning uses the standard troubleshooting functionality of SAP Analysis for Microsoft Office
Monitoring. SAP Analysis for Microsoft Office provides utilities for troubleshooting, such as error messages, log
files and traces. For more information, see the Administrator Guide: SAP Analysis for Microsoft Office at http:/
help.sap.com/boaa .
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4 Business Overview

4.1 Introduction to SAP Merchandise Planning

SAP Merchandise Planning (MP) enables consistent, end-to-end planning, and retail business processes based
on industry best practices. The solution integrates and facilitates channel financial, location-to-merchandise,
and open-to-buy processes including inventory management, purchase planning, and budgeting. It provides a
centralized repository for all planning activities that enable the fast reconciliation of strategic merchandise
plans and reduces the manual effort associated with spreadsheet based planning processes. In addition, there
is standard integration allowing a finalized plan to be consumed by SAP Assortment Planning.

SAP Merchandise Planning is a consuming application of SAP Customer Activity Repository, which contains
the SAP ERP data replicated as follows:

e SAP LT ( Landscape Transformation) Replication Server for SAP HANA. For more information, see the
| Post-Installation » SAP Customer Activity Repository # Configure Data Replication Steps 4. You can find
this guide on SAP Help Portal at http:/help.sap.com/car#|p Installation and Upgrade » Common
Installation Guide 3.

e Demand Data Foundation (DDF)

DDF receives master data and time series data from DRFout processes. For more information, see the
Enabling Demand Data Foundation [page 36] section in this guide.

® Reports for inventory, sales orders and shipments write data to DDF. For more information, see the
Configuration Information of this guide.

4.2 Software Component Matrix

This section provides the software components used by each business process.

During the installation of SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL
BUNDLE 2.0), all of the software components listed below are installed. Whereas all these software

components will be installed, not all of them need to be configured, depending on your implementation
scenario.

For information in installation prerequisites and installation instructions, see section SAP Merchandise Planning
in the Common Installation Guide.
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i Note

This Guide provides just one way to implement each business scenario. Alternative implementations,
including other SAP solutions, business scenarios and processes might be applicable to your specific
business needs.
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4.3 Enabling Demand Data Foundation

SAP Merchandise Planning requires master data and time series data for the productive operation. This data is
not native to this application, and it is created in other applications, such as SAP ERP (SAP S4/HANA, or third
party system).

Note that SAP Customer Activity Repository also receives data replicated from a connected SAP ERP system
by using the System Landscape Transformation (SLT) replication. For more information, see the Common
Installation Guide.

Process

A Caution

You must ensure that the following activities have been performed:

e |nstallation and post-installation steps of the Common Installation Guide

e Relevant configuration information in Configure Demand Data Foundation (DDF).
Note that only the following steps of this business process are relevant for this application:

o Send master data
o Receive master data
o Define sales history

The process to populate master data runs as follows:

1. Send master data (SAP ERP)
SAP ERP prepares and sends the master data through a Data Replication Framework (DRF) (transaction
DRFOUT).
You have the following outbound implementations:

Sequence Replication SAP ERP SAP ERP De- DDF Inbound Interface
Mode Outbound scription
Implementa-
tion
1 Initialization PMCH Material Group /DMF/MDIF PROD HIER INBOUND
Hierarchy )
Product Hierarchy
2 Initialization, PMAT Material /DMF/MDIF PRODUCT INBOUND
Change, and
Product
Manual
3 Initialization, PPLT Plant /DMF/MDIF LOCATION INBOUND
Change, and .
Location
Manual
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Sequence Replication SAP ERP SAP ERP De- DDF Inbound Interface
Mode Outbound scription
Implementa-
tion
4 Initialization, PMPL Material and /DMF/MDIF PROD LOC INBOUND
Change, and Plant )
Product Location
Manual
5 Change PSPR Sales Price /DMF/MDIF_PROD_LOC_INBOUND
Product Location
6 Initialization, PCUS Customer /DMF/MDIF LOCATION INBOUND
Change, and
Manual
7 Initialization, PINV Inventory /DMF/OPIF_INVENTORY_INBOUND
Change, and
Inventory
Manual
8 Change PMAP Moving Aver-  /DMF/MDIF PROD LOC INBOUND
age Price .
Product Location
9 Initialization, ~ Psos Source of Sup- /DMF/MDIF LANE_ INBOUND
Change, and |
& i Transportation Lane
Manual
10 Initialization, PVEN Vendor /DMF/MDIF LOCATION INBOUND
Change, and )
Location
Manual
1 Initialization PAHY Article Hierar- /DMF/MDIF PROD HIER INBOUND
chy )
Product Hierarchy
12 Initialization PPHY Plant Hierar- ~ /DMF/MDIF LOC HIER INBOUND
chy

Location Hierarchy

When carrying out the data replication, the system automatically generates data replication logs, which
you can then evaluate. You can access this option under SAP Easy Access SAP Retail (transaction W10T)

under | Logistics » Retailing » Distributed Retailing » Merchandise Lifecycle Optimization » Outbound ¥

Analyze Log for Outbound Implementations (DRFLOG) .

2. Receive master data (DDF)

By default, the DDF staging tables receive the data. You use the Monitor Imports function to view the data,
transfer the data from the staging tables to the production tables, and to process the received data. For

more information about this function, see SAP Help Portal at http://help.sap.com/car# | <your release>

» Application Help » Demand Data Foundation » General Services » Monitor Imports 3.
DDF performs validation checks before inserting the data into the production tables.
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i Note

You can choose to bypass the staging tables in Customizing under |+ Cross-Application Components

Demand Data Foundation » Basic Settings » Integration » Define Import Settings 3. For more
information, see the Customizing activity documentation (transaction SPRO).

3. Define sales history (DDF)
This application uses point-of-sale (POS) data from SAP Business Warehouse (SAP BW) or from an
external application.
For more information on how to define the sales history, seehttp://help.sap.com/viewer/p/CARAB#r

|» <your release> » Administration » SAP Customer Activity Repository Administration Guide  Getting
Started ¥ Introduction to SAP Customer Activity Repository 3 section Integrating Historical Demand Data.

Result

The system updates the data.

4.4 Developing Merchandise Financial Plan

You use this business process to develop sales, margin, inventory, and receipt flow for the upcoming fiscal year
and seasons at various levels of the merchandise, channel, and time hierarchies. A planner creates a company-
wide merchandise plan at all levels of the merchandise (planned product) hierarchy for all selling channels to
build a receipt (purchase) budget by month and week that is used for Open-To-Buy (OTB) purposes.

Process

The business process runs as follows:

Create merchandise plan summary
Create top-down merchandise plan
Create middle-out merchandise plan

AW

Create bottom-up merchandise plan
5. Perform budget reconciliation

The system updates the planning information.
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4.5 Using SAP Merchandise Planning Workbooks 1.0

These instructions are for users who choose to use the version 1.0 retail workbooks.

If you have upgraded to or have a new installation of SAP Customer Activity Repository applications bundle 4.0
FPS03 and wish to use the version 1.0 retail workbooks you have the following processes.

Developing Financial Plan [page 39]

Developing Merchandise Plan [page 39]

4.5.1 Developing Financial Plan

You use this business process to develop sales and margin plans for the upcoming fiscal years and seasons at
various levels of the merchandise, channel, and time hierarchies. A planner creates a company-wide channel
financial plan by distribution channel and sales organization for all selling channels to build a sales and margin
plan by month and week that is used to seed the merchandise planning and the open to buy processes.

Process

The business process runs as follows:

1. Create channel mix plan
2. Create channel plan
3. Create channel merchandise plan

Result

The system updates the planning information.

4.5.2 Developing Merchandise Plan

You use this business process to develop sales, margin, inventory, and receipt flow for the upcoming fiscal year
and seasons at various levels of the merchandise, channel, and time hierarchies. A planner creates a company-
wide merchandise plan at all levels of the merchandise (planned product) hierarchy for all selling channels to
build a receipt (purchase) budget by month and week that is used for Open-To-Buy (OTB) purposes.
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Process

The business process runs as follows:

s W e

Create merchandise plan summary
Create top-down merchandise plan
Create middle-out merchandise plan
Create bottom-up merchandise plan
Perform budget reconciliation

Result

The system updates the planning information.
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5 Configuration Information

5.1 Configure SAP Merchandise Planning

Use

SAP Merchandise Planning is a consuming application of SAP Customer Activity Repository, which contains
data that is imported from SAP ERP or SAP S/4HANA into the following:

e SAP HANA for SAP ERP using SAP LT Replication Server (SLT), which is saved in the sap_Ecc authoring
schema.
Or
SAP S/4HANA using SLT, which is saved in the sSap_s4H authoring schema.

e Demand Data Foundation (DDF)

Customizing Activities

There are key Customizing activities required to use the SAP Merchandise Planning application. These steps
are performed using transaction SPRO and navigating to the required Customizing activity.

Demand Data Foundation Customizing Node

This node is accessible under |» Cross-Application Components 1.

1. Perform the necessary configuration steps in DDF.
The mandatory activities are marked in the configuration document Configure Demand Data Foundation
(DDF).

2. Configure data replication from SAP ERP to DDF.
SAP Merchandise Planning uses master data (such as product, location, and product hierarchy) as well as
organizational data (such as sales organization and distribution channel) that is replicated from SAP ERP
to DDF using DRFOUT.
This step was performed during installation as described in section [» SAP Customer Activity Repository »
Core (Mandatory for All Applications) 3. See http://help.sap.com/viewer/p/CARAB# | <Version> 3
| Common Installation Guide for SAP Customer Activity Repository applications bundle ¥ Set Up the
Applications .
For more information on setting up this data replication, see the following document Configuring Data
Replication from SAP ERP to DDF.

3. Verify you have entered the Merchandise Planning and Planning Configuration relevant sections in
Customizing activity [» Cross-Application Components » Demand Data Foundation » Basic Settings ¥

Define Default Values 3. For more information see the documentation attached to each activity or the field
level help (F1).
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i Note

Geo Hierarchy ID is only for Merchandise Planning for Retail version 1.1 or prior.

Merchandise Planning Customizing Node

As of SAP Merchandise Planning 2.0 FP2, there is a |» Cross Application Components » 3 Merchandise
Planning node containing mandatory steps for your implementation. Review the table below for applicable
activities for your environment. Each Customizing activity has attached documentation to further explain the
activity.

Technical Name Customizing Path Description

You use this BAdI to overwrite the logic and calculate the
sales-related KPIs in case the default implementation is not
Components  Merchandise suitable for the intended planning scenario.

/RAP/
MPOC CALC SALES KP
I

|# Cross-Application

Planning ¥ Enhancements Using

Business Add-Ins  BAdI:
Calculate Sales KPIs for Retail

and E-Comm Channel 4

You use this BAdI to overwrite the logic to calculate the sales

/RAR/ |} Cross-Applicati
pplication . ) )
MPOC SALES ORDER K order and shlpment related KPIs like sales-type rgvenue,
- - ~  Components # Merchandise cost, and unit. The KPIs that are related to the rejected and
FIS Planning % Enh ts Usi returned sales orders are calculated in case default
anning & tnhancements Lsing implementation is not suitable for the intended planning

Business Add-Ins > BAdI: scenario.

Calculation Sales Order and

Shipment Related KPIs 3
/RAP/ |b Cross-Application You use this BAdI to overwrite logic to calculate the

MPOC_PLANNABLE_L ) Beginning of Period inventory KPIs in case default
Components > Merchandise ) L . ) .
OCAT implementation is not suitable for the intended planning

Planning > Enhancements Using  scenario.

Business Add-Ins » BAdI:
Calculate Inventory KPIs like BOP

Units / Cost 4

/RAP/
MPR CALCULATE ECC

|’ Cross-Application You use this BAdI to overwrite logic in case default

. implementation is not suitable for the intended planning
Components > Merchandise )
KPI scenario.

Planning » Enhancements Using
Business Add-Ins » BAdI: ECC
Calculate Open Qty, Goods

Receipt and Returns KPI }

/RAP/
MPR_CALCULATE FMS

You use this BAdI to overwrite logic in case default
) implementation is not suitable for the intended planning
Components > Merchandise

KPI scenario.
Planning > Enhancements Using

|} Cross-Application
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Technical Name Customizing Path Description

Business Add-Ins ¥ BAdl: FMS
Calculate Open Qty, Goods

Receipt and Returns KPI 3

You use this BAdI to overwrite logic in case default

/RAP/ i o
I} Cross-Application implementation is not suitable for the intended planning
MPR CALCULATE S4H :
KPI_ ~— Components # Merchandise scenario.
Planning ¥ Enhancements Using
Business Add-Ins ¥ BAdI: S4H
Calculate Open Qty, Goods
Receipt and Returns KPI }
/RAP/ |’, Cross-Application You use this BAdI to determine the purchase price for goods

MPR_COST_PRC_DETE ) receipts, open purchase order and returns to vendor KPIs.
Components » Merchandise ) ) ) .
RM The default implementation assumes moving average price

Planning  Enhancements Using g always available in the unit of measure.
Business Add-Ins ¥ BAdl: Cost
Determination for Receipt, Open

Qty and Returns ]

/RAPF/

MPOC_CALC_PO_RECE )
Components > Merchandise )
IPTS_KPI KPIs are based on segmentation and channel.

Planning > Enhancements Using

Business Add-Ins » BAd:
Calculate Goods Receipt KPIs by

You use this BAdI to determine the calculation for goods
receipt, open purchase order quantity and returns to vendor

| Cross-Application

Segmentation & Channel 4

/RAP/

MPOC_CALC_INVENTO c ts % Merchandi
omponents erchandise
RY_KPI P and Excess Inventory Stock based on segmentation and

Planning » Enhancements Using  channel.

|’ Cross-Application You use this BAdI to Calculate Inventory KPIs like Beginning

of Period Cost and Unit Values for Distribution Centre, Store

Business Add-Ins # BAdI:
Calculate Inventory KPIs Based

on Segmentation & Channel }

/RAP/ : )

MPOC STORE COMP |', Cross-Application You use this BAdI to calculate Location (Store Only)
- - - ) comparability by fiscal periods.

DATA Components » Merchandise

Planning > Enhancements Using

Business Add-Ins ¥ BAdl:
Extension to Store Comparability

by Fiscal Period 4
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Technical Name Customizing Path Description

/RAP/ |} Cross-Application You use this BAdI: to select the season year, season,
MPOC_PLANNING_YSC ) collection and theme relevant data for Merchandise
T Components » Merchandise Planning

ing.

Planning » Enhancements Using

Business Add-Ins ¥ BAdI: Select
Season Year, Season, Collection

and Theme 3§

Implementation Tasks

Use of Workbook Versions

The version concept allows you to plan and view different working versions, and to create special versions for
released and finalized plans. Each workbook can display up to two different versions in parallel, with the
capability to copy or provide a working plan version from any other available version to begin the planning
process

The version and planning levels are decided during installation. These concepts will affect your planning
configuration set and integration with SAP Assortment Planning. The recommended standard is planning at
the 5th node level of the product hierarchy (1-7 levels available). The installation will prompt you to create levels
5and 7. The workbook versions are named by concatenating the level with the version. For example the
merchandise financial plan for level 5 versions are:
e o Working Version - M51

o Simulated Version - M52

o Released Version - M5R

o Final Version - M5F

o In Season Version - M5P

Planning Configuration Sets

A Planning Configuration Set (PCS) is a prerequisite to creating a merchandise plan. A planning configuration
defines entry and exit levels for merchandise and option plans based on a market hierarchy (representing an
organizational view on top of retail stores and wholesale customers) and a product hierarchy. The PCS must be
specifically defined in order for the data to render properly in the workbook.

i Note

You must have an area of responsibility assigned for the product hierarchy and market hierarchy you will be
using. From your SAP Easy Access menu, use transaction code NWBC and navigate to menu |+ Services »

Maintain Area of Responsibility 3.

For more information about Planning Configurations see https://help.sap.com/viewer/p/CARAB and navigate
to | <your version> » SAP Assortment Planning » Assortment Planning » Manage Planning Configuration
Sets 1.
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Integration with SAP Assortment Planning.

SAP Assortment Planning is not aware of the finalized version maintained in SAP Merchandise Planning. This
means if you want to send your merchandise plans to an assortment plan, there are setup tasks. The standard
integration is implemented in an AMDP BAdI named /DMF/MPR_READ KPI_DATA which resides in fallback
class /DMF/CL MPR READ DATA DEFAULT. The BAdI works as follows:

e While calling the API to fetch finalized version, the assortment plan interface selects product hierarchy
node(s) of the same level as the plan. For example, based on the product hierarchy node of level 3 (or 4, 5,
6, 7), the system will automatically look for version M3F (or M4F, M5F, etc.) in case the version is not being
passed as part of the API call.

e [f standard integration is used, it is recommended that final released versions should be named as M<level
of product hierarchy node>F.

® A specific custom extension is possible by implementing AMDP BAdI /DMF/MPR READ KPI DATA if your
planning version used for the merchanise plan does not follow the recommended naming convention.

o The BAdI s available using transaction code SPRO and navigating to Customizing node [» SAP
Customizing Implementation Guide » SAP Customer Activity Repository » Demand Data Foundations
Data Maintenance ¥ Planning Configuration » Enhancements Using Business Add-Ins » BAdI: Read
Merchandise Planning KPI Data 3.

5.2 Data Load Reports

Context

While the master data and time series data is processed using DRFout, additional data is sourced from SAP LT
replicated tables. In order to populate Demand Data Foundation with this data, reports are executed to load
initial data at post installation and ongoing delta loads to match your scenario. These processes read replicated
tables in SAP Customer Activity Repository and update DDF.

Procedure

1. /DMF/OPIF INVENTORY INBOUND. You use this program to populate historical inventory for a given date
and location. Use transaction code se37 for further documentation or to execute.

2. /RAP/MPR ECC KPI CALC. You use this report to populate goods movement key performance indicators
(KPI) of returns, receipts, and open quantity. This report must be run during the post installation process
to load 2 years of historical data. It is recommended you run this report weekly to update the aggregated
KPIs with the ongoing ERP activity. Use transaction code sg38 for further documentation and to execute.

SAP Merchandise Planning 4.0 FPSO3 Administration Guide
Configuration Information PUBLIC 45



6 Optimize SAP Merchandise Planning
Performance
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.
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or for any purpose without the express permission of SAP SE or an SAP
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